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PHY 1048L         Physics Laboratory I 

 L1: Introduction and Room Width 

 

Analysis Using excel: Excel Basics 

Introduction 

An important objective of this laboratory course is to familiarize you with the use of the computer to 

process experimental data. We will use Excel, the most widely used spreadsheet program.  Because all 

spreadsheet programs are basically the same, mastering Excel will enable you to quickly learn other 

versions of Excel, Quattro Pro, or other spreadsheet programs.  Moreover, there are many practical, 

non-science uses for spreadsheets, so learning this skill will help you at home or in almost any 

occupation.  If you are already familiar with spreadsheets, you will have an opportunity to enhance 

your skills and to help your instructor pass on these skills to your classmates.  If this is your first 

exposure to spreadsheets, you will likely find this experience one of the most rewarding aspects of the 

course.  Past students have commented that learning spreadsheets was a most valuable aspect of the 

course.  

 

Overview 

The spreadsheet concept is uncomplicated; a spreadsheet consists of a two-dimensional grid system.   

Each cell is identified by two coordinates:  the columns by letters (A, B, C...), and the rows by 

numbers (1,2,3,...) as shown below.  

 A B C D E 

1      

2      

3      

4      

5      

6      

Each cell has a unique identity, e.g., A1, A5, and B6.  When you click on a cell, it will appear outlined 

with a small square box in the lower right hand corner.  You can type numbers, letters, or formulas in 

that cell.  When done, press enter and use the mouse as needed to go to another cell. 

 

The power of spreadsheets derives from your ability to type a formula into a cell.   All formulas begin 

with the = sign.   If you type “=A1+A2” into cell A3, the computer will add the contents cells A1 and 

A2 and place the numerical result in A3.  Try this.  Only the numerical result will show in A3, but if 

you look toward the top of the screen, the formula you entered will appear in the edit box.  If you want 

to edit this equation without totally retyping it, simply click on the equation in the edit box, make 

changes, and press enter when done.  Operations far more complex than simple addition are possible. 

 

Entering Experimental Data 

Experimental data is most often entered in columns.  Start by typing a heading or title, this should 

include parameter and unit, e.g. Time(s), for a column.  Then, type numerical data in the cells below 

the heading.  If you make a mistake, you can go to another cell and then return to the original cell, 

overwriting your original entry.  You can also click on the edit box and edit the cell contents, pressing 

enter when done. 

 

Entering Formulas 

There are several ways to build formulas. First, click on the cell where you want the answer to appear.  

The most straightforward approach is to type the = sign followed by the formula you want, e.g., putting 

“=(A1+A2)/2” into cell A3 would produce the average of A1 and A2.  You can also build this 

expression using these steps: 
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 Click on A3 

 Type =( 

 Click the mouse on cell A1 

 Type + 

 Click the mouse on A2 

 Type )/2  

 Press enter 

 

You could even do the job by directly typing “=AVERAGE(A1:A2)” into A3 which takes the average 

of all cells between the cell locations specified before and after the colon.  Note that formulas cannot 

contain any spaces.  A common mistake is to accidentally place a space before the = sign where it is 

hard to detect.   

 

Copying Formulas 

Consider that you have in put the data below and want to calculate the area for each pair of width and 

length measurements. 

 A B C D E 

1 Width Length Area   

2 2.5 2.0    

3 3.0 2.1    

4 3.3 2.7    

5 4.4 3.1    

6      

Click on cell C2, enter the formula: =A2*B2, press enter.  The number 5.0 will appear in C2.  To copy 

this down into cells C3, C4, and C5: 

 Click on C2 again 

 Move the cursor over the small square on the lower right hand corner of the cell until the 

cursor becomes a cross 

 

Press down on the mouse button; drag it down to cell C5 before releasing the button. 

The spreadsheet will now look like this. 

 A B C D E 

1 Width Length Area   

2 2.5 2.0 5.0   

3 3.0 2.1 6.3   

4 3.3 2.7 8.91   

5 4.4 3.1 13.64   

6      

Click on cell C5 and look at the equation in the edit box.  You will notice it is “=A5*B5” so the 

computer has adjusted the formula.  This beats typing the formula 3 more times.  You can also use the 

copy, cut, and paste commands under the edit menu for text, numbers, or formulas as you do with word 

processors.  You should become proficient in both these methods. 

 

If you would next like the sum of the 4 areas to appear in cell C6, you could type “=C2+C3+C4+C5” 

or “=SUM(C2:C5)”.  You could even use these steps:  

 Type =SUM( 

 Highlight the cells from C2 to C5 

 Press enter 
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You would get the following. 

 A B C D E 

1 Width Length Area   

2 2.5 2.0 5.0   

3 3.0 2.1 6.3   

4 3.3 2.7 8.91   

5 4.4 3.1 13.64   

6   33.85   

 

Consider now that you have gathered some radius measurements for circles and wish to calculate 

areas.  Note that you have placed a value for   in B1. 

 A B C D E 

1 Pi= 3.14    

2 Radius Area    

3 2.1     

4 2.7     

5 2.2     

6 1.9     

 

Since A  r
2

, you would type “=B1*A3^2” in B3.  However, if you copied this down as before, 

you would have “=B4*A7^2” in B6.  Clearly, B4 does not contain  .  To copy this down correctly, 

you need to prevent B1 from changing as follows:  

 Click on B3 and go to the edit box to edit the formula 

 Place the cursor on B1 

 Press the F4 key on a PC. The formula will change to =$B$1*A3^2 

 Press enter 

When you copy this revised formula, B1 will never change, yielding the spreadsheet below.  If you had 

held the Apple key down, and pressed the T key again, it would have cycled through holding the row or 

column constant, finally returning to simply B1 without he $ signs.  

 

 A B C D E 

1 Pi= 3.14    

2 Radius Area    

3 2.1 13.8474    

4 2.7 22.8906    

5 2.2 15.1976    

6 1.9 11.3354    

 

Using the Function Feature 

In this course you are likely to know the syntax to get Excel to calculate sums, averages, standard 

deviations, slopes, and intercepts, i.e.,  

 

Average: =average(x1:xn) 

Standard Deviation: =stdev(x1:xn) 

Slope: =slope(y1:yn, x1:xn) 

Intercept: =intercept(y1:yn, x1:xn) 
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However, if you forget these or want to perform some other operation, you can select Function under 

the Insert menu or press the fx button.  You will see an incredible number of selections to include, for 

example, all the trigonometric functions.   

Slopes and Intercepts 

Although the average and standard deviation functions only have one argument, the slope and intercept 

functions have two arguments, x and y.  You are calculating the best fit straight line that fits your x and 

y data.  This mathematical operation is called a Least Squares or Linear Regression Fit to the data.  

Before calculating the slope and intercept you must identify your x and y data which presumably are 

located in two columns of your spreadsheet as shown below.  Assume that you want the slope and 

intercept to appear in cells B5 and B6 as indicated by the alphanumeric labels typed into A5 and A6. 

 

 A B C D E 

1 x data  y data    

2 2 3    

3 3 4    

4 4 6    

5 Slope=      

6 Intercept=     

 

To put the slope in B5 use these steps: 

 Click on B5 

 Type: =slope( 

 Highlight your y data B2:B4 

 Highlight your x data A2:A4 

 Press enter 

 

The computer program even puts in the parenthesis for you.  Put the intercept into B6 in the same way 

to obtain the following. 

 

 A B C D E 

1 x data  y data    

2 2 3    

3 3 4    

4 4 6    

5 Slope= 1.5    

6 Intercept= -.166667    

 

Graphing and Plotting 

Plotting is one of the great features of spreadsheet programs.  Before starting, plan ahead. Make 

sure your column of x data is to the left of your y data. Excel assumes this to be the case, regardless 

of what you tell it. Assume you want to plot the following x-y data. 

 A B C D E 

1 x data y data    

2 1 1    

3 2 4    

4 3 9    

5 4 16    

6 5 25    
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Follow these steps to produce a scatter plot--the type most used for experimental data. 

 

 Highlight your x and y data simultaneously by highlighting the block of cells from A2 to B6.  

Note if your x and y data are separated by other columns, hold the control key down while you 

individually highlight the x and y data columns.  Do not include the titles on row 1, just numerical 

data. 

 Press the Chart Wizard icon on the upper right portion of the menu bar.  It looks like a vertical 

bar chart or go to INSERT, then CHART. 

 Double click quickly on the xy(scatter) plot which is usually the type you will use or single click it 

and press next. 

 You will now see your plot with actual data points displayed.  Note that if you don’t like it, you can 

go back and change something.  Confirm that the data series are in columns. 

 Press next.  You will now see your chart and be able to add a title and label the axes. 

 Click the cursor in the title and label boxes, and type in the labels you want.  The actual 

information you enter will appear on the plot after a moment.  Do not press enter until you are 

satisfied with your plot or at least have made an entry for the title and each axes.  Prematurely 

pressing enter will take you out of the chart wizard and makes it difficult to add titles or labels to 

your plot later; it is relatively easy to change a title or label as long as you put something in 

initially. 

 Select having your object in the sheet.  

 Press finish and your final chart will appear on your spreadsheet.  

 Resize your chart.  Note that the border of the chart will have small boxes at each corner and the 

middle of each side.  Place the cursor on any of these boxes, press down on the mouse, and stretch 

the plot to the size you want. 

 Relocate your chart by placing the cursor anywhere on the border of the chart other than on one 

of the small boxes.  When the cursor changes to an arrow, press down on the mouse and move the 

plot to the selected location. 

 Click on a spreadsheet cell outside of the plot area to exit the plot; click again on the plot to 

change its location or size again.  Double-clicking on the plot will open the plot so you can make 

changes to the title, type of chart, etc.  This is what you should have if you have used the above 

steps. 
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Printing 

You may print your spreadsheet using the following steps: 

 

 Select Print Preview under the File menu. 

 You will now see how your spreadsheet would look when printed.  It is unlikely to be in an 

acceptable format. 

 Press Setup 

 Select the best orientation--usually landscape--and select scale to fit page.  At this point, you can 

change headers and footers, etc.  

 Press OK to take you back into print preview to see what your spreadsheet will look like 

 Press Margins to display current settings.  You can simply click and drag them around to center 

your chart or otherwise get it the way you want it 

 Press Print to Print or Close to return to the spreadsheet.  You can always select Print under the 

File menu, but only do so after you have previewed your work.  You will be asked to verify the 

number of copies and the destination printer before printing takes place 

 

To print just a full size chart on a page without the spreadsheet, double-click on the chart until you 

open it.  Then go to print preview to get the page the way you want it 

 

Saving Your Work 

It is important to periodically save your work.  Almost everyone working with computers has 

experienced a computer lockup where all is lost except what you last saved.  We suggest that before 

inputting data you select Save As under the File and save your spreadsheet to a removable drive. Note 

that any files saved on the hard drive will be lost if there is a power fluctuation.  Lab computers 

contain software, which automatically removes any student-saved files every time the computer is 

rebooted.  Thus a power loss means data loss if the file is saved on the hard drive. Once you have 

saved it to a removable drive, you can use the Save Icon located in the upper right part of the menu bar 

every so often.   When you are done with your spreadsheet Save and Close it from the File Menu.  This 

way you have a copy on your removable drive and can go to any other computer to view, print, or 

change your spreadsheet. 
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Name:_____________________________________________________________________________ 

Exercise: Using Excel to analyze the Room Width 

1. Measure the width of the room in meters to the nearest 0.001 m four times and record the 

measurements in the table below. The width of the room for this exercise is defined as the distance 

between the two walls that have no windows. Before starting, be sure to take a minute or two with 

your partners to plan out how you will do it. 

 Measured Values (                 ) 

1  

2  

3  

4  

2. Go to one of the lab computers and open Excel and create a spreadsheet using your four values, to 

calculate the mean and standard deviation of your data. (see Page 8) 

 

3. Print your results. Then close your spreadsheet. Hand in your print out with the completed lab. 

 

4. Now return to your lab bench and try the same calculation with your hand calculator. You should 

get the same results. 

Error analysis equations – Show your calculations here 

a. Mean  
n

x
x i
               Where xi = i

th
 experimental value   

 

 

 

 

 

Spreadsheet Value:_________________________ Calculated Value:_________________________ 

b. Deviation xx                                 n = no. of experimental values 

 

 

 

 

 

 

 

Spreadsheet Value:_________________________ Calculated Value:_________________________ 

 

c. Standard deviation

 
14

)()()()(

1

)( 2

4

2

3

2

2

2

1

2










 xxxxxxxx

n

xxi
  

 

 

 

 

 

 

Spreadsheet Value:_________________________ Calculated Value:_________________________ 



 8 

d. % error 100*%
x

error


  

 

 

 

Spreadsheet Value:_________________________ Calculated Value:_________________________ 

 

5. Discuss with your lab partners what errors and problems you encountered and conclude how well 

you measured the width of the room. Please be able to say you measured it to within some number 

of meters, e.g., within +/-0.003m. State the result of this discussion below. 

 

 

 

 

 

 

 

 

 

 

Room Width Spreadsheet 
 

 A B C 

1  Measured  

2  Values X-mean 

3 1 4.773 -.010 

4 2 4.811 .028 

5 3 4.770 -.013 

6 4 4.777 -.006 

7 Mean = 4.783  

8 Standard dev = 0.19  

9 Percent Error = 0.40  

10 Mean + 2 sigma = 4.821  

11 Mean – 2sigma = 4.745  

 

Room Width Spreadsheet Formulas 

 A B C 

1  Measured  

2  Values X-mean 

3 1 4.773 = B3-$B$7 

4 2 4.811 = B4-$B$7 

5 3 4.77 = B5-$B$7 

6 4 4.777 = B6-$B$7 

7 Mean = = Average(B3:B6)  

8 Standard Dev = = STDEV (B3:B6)  

9 Percent Error = = B8/B7*100  

10 Mean + 2sigma = = B7 + 2*B8  

11 Mean – 2sigma = = B7 - 2*B8  

 


